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About this Manual
Conventions used
1 About this Manual

This Manual contains information about Lenze Cam Designer Basic.

The »Cam Designer Basic« is a software which is used to transfer recipes consisting of mo-
tion profiles, cam tracks and position markers from a PC to Lenze target systems.

Special features of the »Cam Designer Basic« are:

 Import of CAD data via standardised interfaces (VDI 2143).

 Program operation via an easy-to-use PC user interface for the first commissioning and 
the preparation of additional functions to be provided to the final user by the mechan-
ical engineer.

 Smoothing of imported CAD data (motion profiles) for a smoother running of the 
drives.

1.1 Conventions used

This Manual uses the following conventions to distinguish between different types of in-
formation:

Type of information Marking Examples/notes

Variable identifier italic Set bEnable to TRUE to...

Window The message window... / The  Options dialog box...

Control element bold The OK button... / The Copy command... / The Properties tab... / The 
Name input field...

Sequence of menu 
commands

If the execution of a function requires several commands, the individual 
commands are separated by an arrow: Select FileOpen to...

Keyboard command <bold> Use <F1> to call the Online Help.

If a command requires a combination of keys, a "+" is placed between 
the key symbols:
Use <Shift>+<ESC> to...

Program listings Courier IF var1 < var2 THEN
    a = a + 1
    END IF

Keyword Courier 
bold

Link underlined Links are highlighted references which are activated by means of a 
mouse click.

Safety information  �Layout of the safety information  ( 6) 

Step-by-step instruc-
tions  Like safety information, step-by-step instructions and tips can be recog-

nised by an icon.

Tip 
L 2.1 EN - 09/2005 5
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1.2 Layout of the safety information

All safety information have a uniform structure:

 The icon characterises the type of danger.

 The signal word characterises the severity of danger.

 The note describes the danger and suggests how to avoid the danger.

 Signal word

Note

Icon Signal word Meaning Consequences if disregarded


hazardous 
electrical 
voltage


general dan-

ger

Danger! Impending danger to persons Death or severe injuries

 Stop! Potential damage to material Damage to the controller or its environment

 Note! Note
6 2.1 EN - 09/2005 L
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System requirements

Connection with the target system

2 System requirements

The following minimum requirements on hardware and software must be met to use the
»Cam Designer Basic«.

 Microsoft® Windows® 98, Windows NT® 4.0 (as of Service Pack 5), 
Windows® 2000 (as of Service Pack 2) or Windows® XP.

 64 MByte RAM
128 MByte RAM (Windows® XP/2000)

 IBM compatible PC (CPU: Pentium 90 MHz processor or faster)

 Super VGA screen

 Hard disk with at least 120 MB of free disk space

 CD-ROM drive

 Mouse (Microsoft-compatible)

2.1 Connection with the target system

The communication with the target system (controller, Servo PLC or 9300EK servo cam) re-
quires a fieldbus-specific interface module for the PC and the corresponding fieldbus mod-
ules for the target systems to be connected.

For system bus (CAN) communication, Lenze offers the following components as interface
module for the PC:

Bus system Max. number of target systems

PC port Required hardware components

System bus (CANopen) 63

Parallel
port
(LPT port)

PC system bus adapter 2173
incl. connection cable and voltage-supply adapter
 • for DIN keyboard connection

(EMF2173IB)
 • for PS/2 keyboard connection

(EMF2173IBV002)
 • for PS/2 keyboard connection with electrical isolation

(EMF2173IBV003)

USB
(Universal Serial Bus)

PC system bus adapter 2177
incl. connection cable
(EMF2177IB)
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3 Software installation

 How to install the »Cam Designer Basic«:

1. Start Windows.

2. Insert the CD-ROM »Cam Designer Basic« into the CD-ROM drive.

 • If the auto-start function of the CD-ROM drive is active, the installation program 
is started automatically and you can proceed with step 5.

3. Select Run ... from the start menu.

4. Enter the letter for your CD-ROM drive followed by ":\setup.exe" (e.g. "e:\set-
up.exe") in the command line and confirm with OK. 

5. Follow the instructions of the installation program.

 Note!

Installation under Windows NT/2000/XP requires administrator rights!
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4 Introduction

»Cam Designer Basic« is a graphic tool for the easy creation of electronic cams.

»Cam Designer Basic« provides the features of the »Cam Designer Professional« in reduced
form.

Main features of the »Cam Designer Basic«

 Easy creation of cams by means of graphic objects (e.g. lines, polynomials).

 Data is directly input using the physical unit.

 Display of speed, acceleration torque and jerk.

 Printing of the cam graphics with project information and date.

Main features of the Software Package - Cam

 48 profiles can be stored in the PLC

 289 base points per profile in the relative data model

 116 base points per profile the absolute data model

 Increased number of the available base points with reduced number of profiles re-
served

 48 cam groups can be stored

 Three tracks per cam group

 Four cams per tracks

Main features of the 9300EK servo cam

 8 profiles can be stored in the PLC

 256 base points per profile in the relative data model

 64 base points per profile the absolute data model

The »Cam Designer Basic« is a product of the Software Package - Cam. It manages the rel-
evant data of the machine and also creates projects. However, it lacks the »Cam Manager«
and hence the ability of managing several products at the same time.

 Note!

No names are used for profiles and projects in the documentation. The examples 
use the names assigned by the system. You can assign names on your own in 
your system.
L 2.1 EN - 09/2005 9
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Entries via the »Cam Designer Basic«

 The project
Only one product at a time is available, i.e. only one product at a time can be processed.

– Machine structure

– Names of the axes

 The feed constant and gearbox factor of each axis

 Scaling of the axes for profile creation

 The master axis

– Number of cycles of the machine
The value is a rated value and can maximally amount to 199% during operation.

 The slave axes

– Number of profiles to be stored

– Number of base points to be assigned

– Selection of the data model

 The product (profiles)

– Product name

– Product number

 Note!

No names are used for projects and products. The names given by the »Cam De-
signer Basic« are continued to be used. You are able to select the names on your 
own in your project.
10 2.1 EN - 09/2005 L
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Advantages of »Cam Manager«

the »Cam Manager« is not included in the »Cam Designer Basic«.

The management of projects with several products and the corresponding axes using the
»Cam Designer Basic« is only possible with a directory structure.

The »Cam Designer Professional« manages the projects using the integrated »Cam Man-
ager«.

The assignment between products and axes is displayed in the »Cam Manager«.

 The products and axes are stored and managed automatically in the »Cam Designer 
Professional«.

 The storage and management of the products and axes in the »Cam Designer Basic« 
are provided by means of the *.LCx-files and *.cam-files

– LC9 for Servo PLC and ECS EA

– LC7 for 9300 EK servo cam
L 2.1 EN - 09/2005 11



Cam Designer Basic
Introduction
Motion tasks
4.1 Motion tasks

According to the VDI 2143 with the title "Motion rules for cam mechanisms" the motion
tasks can be classified as follows:

These four motion tasks serve to formulate the technological specifications for all prob-
lems relevant to practice.

For calculating the profile segments between the defined sections, the boundary values of
the specifications are required.

 Since the acceleration for R and G is = 0, these two motion tasks can be described line-
arly. The boundary values on the left and right connection are identical in this case.

 The acceleration for U and B is ≠ 0. These elements can be represented as a point on the 
worksheet.

After entering these basic elements for the motion tasks and determining the required
boundary values, the connections can be entered according to the motion rules. Depending
on the connection type used, a jerk-free motion can be achieved.

Motion task Abbreviation Speed in the 
boundary point

Acceleration in the 
boundary point

Graphical
representation

Break R v = 0 a = 0 Line

Constant speed G v ≠ 0 a = 0 Line

Reversal U v = 0 a ≠ 0 Point

Motion B v ≠ 0 a ≠ 0 Point
12 2.1 EN - 09/2005 L
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Scaled motion rules
4.2 Scaled motion rules

Each segment i of the whole cam describes a part which is defined by the value range si0 =
f(ji0) and si1 = f(ji1).

 The corresponding functions are imaged internally to the scaled value range of 0...1.

 The coefficients of the profiles, included in the property pages, also refer to this scaled 
value range.

 The speeds and accelerations in the property page represent the real boundary value 
with regard to the geometrical dimensions. Thus, the calculation is based on the rule 
v = ds / dj and a = d2s / dj2.
These geometrical values for speed and and acceleration are also used in the graphical 
representation.
L 2.1 EN - 09/2005 13
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Using the direct help
5 User interface

 Go to the Start menu and select 
ProgramsLenzeGlobal Drive Cam Designer Basic to start the
»Cam Designer Basic« with user interface.

The user interface contains the following control and function elements:

5.1 Using the direct help

The »Cam Designer Basic« has a direct help which can be used to display information about
specific areas of the user interface.

 Select the command HelpDirect help and click the area about which you want to 
obtain more detailed information.

If you have opened e.g. the dialog box Project settings and click the input field Rated quan-
tity cycle/min, information about this dialog object is displayed when pressing <F1>.

 Title bar  Toolbar Screen divider  Workspace

 Menu bar Project structure  Status bar Output area
14 2.1 EN - 09/2005 L
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Language selection
5.2 Language selection

You can always select another language for the menu, dialog and help texts of the »Cam
Designer Basic«.

 The available languages depend on the language files that have been installed togeth-
er with the »Cam Designer Basic«.

 How to select another language...

1. Select command ViewSet language.

2. Go to the Language configuration dialog box and select the desired language.

3. Click OK to confirm your selection and close the dialog box.

5.3 Title bar

The title bar at the top of the application window shows the program icon and the program
name on the left and the window icons on the right.

 With a click on the Window icons � � �  you can change the representation of the 
application window as follows:

– Icon in the task bar (�)

– Full screen (�)

– Window size (�)

 A click on the program icon opens the system menu which also includes commands for 
positioning and changing the size of the application window.

 A click on the window icon U or a double-click on the program icon exits the »Cam De-
signer Basic«

5.4 Menu bar

Via this menu bar you have access to all menu commands of the »Cam Designer Basic«. In
contrast to the »Cam Designer Professional« the profile functions are reduced.

 A click on an item of the main menu opens the corresponding menu and lists the menu 
items contained in it.

 Click a menu item to execute the corresponding function.

– Menu items which are displayed in light grey are currently deactivated because the 
execution of the corresponding function would not make any sense in the current 
program state.

 Tip!

Many frequently used functions can be executed faster by means of the Toolbar
icons. ( 16) 
L 2.1 EN - 09/2005 15
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Toolbar
5.5 Toolbar

The display is optional.

Via the icons of the toolbar you can easily execute some of the most frequently used menu
commands without making a detour via the Menu bar. The selection of the available func-
tions depends on the active mode/window.

 Simply click an icon to activate the corresponding command.

Icon Menu command Function

FileNew Creates a new Cam Designer Basic project.

FileOpen Opens a Cam Designer Basic project.

FileSave Saves the project under the current name.

FilePrint Prints the project.

EditCut Deletes a selected object and moves it to the clipboard.

EditCopy Copies a selected object and moves it to the clipboard.

EditPaste Pastes a copied or cut object into the current position.

EditUndo Undoes the last action.

EditRedo Redoes the last undone action.

ViewZoom In Enlarges the worksheet view.

ViewComplete View Resets the worksheet view to standard size.

Edit
Acceleration Dimensioning

Opens the acceleration dimensioning dialog.

File
Connect to OPC Server

Establishes a connection to the OPC server.

File
Create LCx-file and Download

Opens a dialog for selecting a drive.

DrawSelect Selects the drawing objects.

DrawLine Draws a line.

DrawPolynomial (5.) Draws a 5th grade polynomial.

DrawSloped Sine Draws a sloped sine function (Bestehorn).

DrawTable Draws a table.

ViewObject Input Mode Input of motion objects.
16 2.1 EN - 09/2005 L
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Project structure
 Tip!

If you move the mouse pointer over an icon, a tool tip pops up providing a short in-
formation on the corresponding function. Moreover, an additional information is
displayed in the Status bar.

5.6 Project structure

The display is optional.

The project structure consists of the tabs Project and Object.

Project

In this tab the master axis and the created slave axes are displayed.

 A double-click on the icon activates the corresponding slave axis. The associated pro-
files are displayed accordingly.

 A mouse-click highlights the name of the master or slave axis in blue. When clicking the 
blue field, the name can be changed.

ViewInterpolation mode Changes to the interpolation mode.

Edit
Start Calculation

Connects the profile segments.

Icon Menu command Function
L 2.1 EN - 09/2005 17
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Object

This tab shows the list of all objects in the active mode. Optionally, the objects of the lower
levels, highlighted in grey, can also be shown.

 Each line in the list contains the object type and coordinates of the object. The lines are 
sorted according to the X values (master) as standard. A different sort sequence can be 
achieved by a mouse-click on the fields in the headline.

 It is possible to select one or several objects in the list by means of the mouse. The se-
lection is also transferred to the graph of the worksheet.

 A click with the right mouse button on the corresponding object opens a submenu 
which contains various functions. The property dialogs of the objects can be opened, 
the object can be copied or deleted.

In the Objects tab, the lines, profiles etc. can be edited. 

5.7 Screen divider

The screen divider is the border between two non-overlapping windows. In the »Cam De-
signer Basic« there is a screen divider between the worksheet, time derivations and the ob-
ject list.

5.8 Workspace

The document windows (worksheets) are displayed in the workspace. 

 When the»Cam Designer Basic« is started, the workspace is blank because there are no 
open projects.

 The worksheet is the area for entering and editing graphic objects.

5.9 Output area

The display is optional.

 This diagram displays the time derivations of the objects from the worksheet.

 In this diagram, the cams of the individual tracks for the target systems Servo PLC and 
ECS EA can be created and edited.
18 2.1 EN - 09/2005 L
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5.10 Status bar

The display is optional.

The program status is indicated in the status bar.

The status bar describes the action which is executed by the menu item selected or a
pressed button of the toolbar and displays the coordinates of the mouse pointer.

 Tip!

If you position the mouse pointer over an icon in the Toolbar or a menu command,
more information about the corresponding function will be indicated in the status
bar.
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5.11 Document window (worksheet)

If you open a project, the corresponding worksheet will be indicated in a document window
in the Workspace of the Cam Designer Basic.

By default, the document window is displayed on a full screen, i.e. the document window
fills the whole workspace of the»Cam Designer Basic«.

 With a click on the window icons � � �  at the top right of the document window 
you can change the representation of the document window as follows:

– Icon within the workspace (�)

– Full screen (�)

– Window size (�)

 A click on the program icon opens the system menu which also includes commands for 
the positioning and size of the document window.

 A click on the window icon U or a double-click on the program icon closes the docu-
ment window.

 Use the key combination <Ctrl>+<F6> to jump from one document window to the next 
document window.

"Window" menu

The Window menu contains the following commands for the arrangement of the docu-
ment window:

Command Function

New window Opens a new window with the same contents as the active window.
In this way, it is possible to display different parts or views of a worksheet simultaneously.
 • The new window will be automatically the active window and will be indicated above all 

other open windows. 
 • If the contents of an open window is changed the contents of all other open windows of 

the project change as well.

Cascade Cascades all windows in the workspace.

Horizontal Arranges all windows in the workspace horizontally.

Arrange icons Arranges all windows reduced to an icon at the bottom of the workspace.
 • If a window opens in this section, it may happen that one or all icons are hidden because 

they are under the window.

1, 2, 3... All open windows are listed at the end of the Window menu.
A click on an entry activates the corresponding window (and places it on top of the desktop).
 • The active window is indicated by a hook in front of the entry.
20 2.1 EN - 09/2005 L



Cam Designer Basic
Operation
6 Operation

After the first start of »Cam Designer Basic« the user interface is displayed with an empty
workspace.

 Now you can create a new project (worksheet) or open an existing project.

 Tip!

In the installation directory of the »Cam Designer Basic« you can find example
projects which can be used to make yourself familiar with the operation of the
»Cam Designer Basic«.

What do you want to do?

�Create a new project ( 22) 

�Open an existing project  ( 34) 
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6.1 Create  a new project

After starting the »Cam Designer Basic« the user interface is displayed with the master axis
and a slave axis. You can either continue to process the project or call a new project.

 How to create a new project...

Go to the symbol bar of the »Cam Designer Basic« and click the symbol  or select 
FileNew to start a new project:

Detailed information about the individual steps can be found in the following subsections.

6.1.1 Step 1: Defining the features of the master axes

The entries in the axes reflect the machine constants. Therefore, only work with real val-
ues.

 The master axis can be a real or virtual axis.

The master axis has the features of an electrical shaft.

 Note!

If you only use a virtual master, then enter in the group field Machine under 
Gearbox factor in the input field z2 100 and in z1 1. This serves to achieve a high-
er resolution of the master angle.
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The following overview shows the relevant global data for the electrical shaft function. Sig-
nal flow between the template functions for the Electrical shaft.

 Enter the indicated values into the dialog box Master ein.

Dialog object Description

Input field Name Name of the master axis

Input field Minimum In the dialog box Master the 0.0000 must always be entered here.

Combination field Unit * The unit used

Input field Maximum * Cycle
 • An electrical shaft can be divided e.g. from 0° to 360° or from 0 to 100mm.
 • In this case, one master cycle amounts to 360° or 100mm

Input field Cycles/min Production cycles in 1/min
The value can maximally amount to 199%.
 • The machine speed which you want to reach with this profile can be set in the in-

put field Cycles/min.
 • Serves the display

– to dimension the acceleration
– of the time cams of the cam group.

Input field
Rated cycles/min

Production cycles in 1/min
The nominal value can maximally amount to 199%.
 • The maximum possible machine speed can be entered in the input field Rated 

quantity cycle/min.
This entry is important for the acceleration precontrol. 
(Servo PLC / servo cam 9300EK)

Input field
Gear factors z2/z1 *

Ratio of an upstream gearbox.
 (e.g. 100/1 as real value)

Input field Feed constant * Path per revolution at the output end of the gearbox
(if an angle is stated, one revolution = 360°)
The physical unit entered is converted to the encoders.
 • Enter, for instance, the leadscrew pitch.
 • When entering increments, enter the number of increments per revolution.

Fields must be filled with * !
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 How to define the properties of the master...

1. Go to the Master dialog box and select the properties of the master.

 • The Name of the master is indicated on your worksheet.

 • The Cycles are the maximum number of operating cycles per minute.

2. Click Next to proceed with the next step.

6.1.2 Step 2: Defining the properties of the slave axis

The entries in the axes reflect the machine constants. Therefore, only work with real val-
ues.

 Enter the indicated values into the dialog box Slave.

 Note!

If you use a virtual master, enter in the group field "Machine" under "Gearbox 
factor" 100 in the input field z2 and 1 in the input field z1. This serves to achieve 
a higher resolution of the master angle.
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Dialog object Description

Input field Name  • The slave axis must have a definite name (e.g. Slave1)
and must not be used for other slaves at the same time.

 • The name of the slave axis is used by the CamDesigner. CamDesigner creates a 
Slave1.LC9 or Slave1.LC7.
In this *.LC9-file or *.LC7-file all profile data, cams and position marker are stored.

Input field Minimum * Set range of motion

Input field Maximum  *

Combination field Unit * Selection of the unit

Control field

Absolute data model

Relative data model

When using the absolute data model, you have internal or external (PC) access to 
each single base point. However, a fewer number of base points is available then.
 • If the control field Absolute data model is not marked, the relative data model is 

used. When using the relative data model, more base points are available. The 
base points are distributed automatically.

 • If the relative data model is used, the entire profile can only be accessed with the
Cam Designer Basic/Professional or Cam Loader to change profile data. The pro-
file data cannot be changed via access from a PLC.

Input field Curves * Maximum number of the curve profile to be stored.
Reserves should be considered in the maximum number of curve profiles.

Input field Points * Number of base points
Maximally 1 base point/ms or less

Group field
Background layout

Curves are distinguished by colour.
Improved representation of the curves in multi-axis applications.

Input field Gearbox factors 
z2/z1 *

Ratio between motor and tool
Example: multi-stage gearbox
Gearbox numerator = z2 × z4 = 28 × 32 = 896 (value of z2)
Gearbox denominator = z1 × z3 = 23 × 15 = 359 (value of z1)

Input field Feed constant  * Path per revolution at the output end of the gearbox.
(If an angle is stated, one revolution = 360°)
The physical unit entered is converted to the encoders.
 • Enter, for instance, the leadscrew pitch.
 • When entering increments, enter the number of increments per revolution.

Group field
Data of drive controller

The selection field Type serves to select a target system.
 • Servo PLC/ECS servo system
 • 9300 EK (9300 servo cam)
The input field GDC file serves to import a GDC file.
 • Only if 9300 EK (9300 servo cam) has been selected.
Assignment of a drive via the bus address.
Shows the path of the selected drive.
The button ... serves to select a drive.
 • The assignment is only necessary if profiles, cams etc. are to be changed.
 • To change profiles, cams etc. online, all drives must be online.

Fields must be filled with * !
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 The name of the slave axis is shown in the worksheet and also used for the LCx-file. 
Moreover, a subdirectory with this name is created in the project directory.

 When selecting the Type "9300 EK (9300 servo cam profiler)" you can optionally indi-
cate the corresponding GDC file. The Gear factors and the Feed constant will then be 
automatically read from this file.

 If you have an online connection you can use the  button after the Drive input field 
to assign a drive to the slave axis.

 The selections under Absolute data model and Curve have a direct influence on the 
maximum number of points. If you need more points for the table of points deactivate 
the selection Absolute data model and use the relative data model or reduce the value 
under Curve. 

 The maximum Curve depends on the selected type.

 How to define the properties of the slave...

1. Go to the Slave dialog box to select the properties of the slave axis.

2. Click Next to proceed with the next step.
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6.1.3 Step 3: Set profile options

The General dialog box can be accepted as shown.
When using the menu command EditProject Settings... the Settings dialog box is dis-
played. In the dialog box the project settings can be changed afterwards. 

 Enter the indicated values into the dialog box General ein.
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 In the input field Product number a numerical value can be entered for the profile to be 
processed.

– Servo PLC, 0 to 47

–  9300EK servo cam, 0 to 7

 Press the button  to open the path in which the files (LCx-files) are stored.

For the download via DDS or Global Drive Loader the files can be loaded from the directory. 

After the basic settings have been selected by means of the wizard, you can add more
slaves to your project if required for your drive application.

Dialog object Description

Option field
Automatic rounding

All position values of the master(X) and slave(Y) are automatically rounded to suita-
ble values.

Option field
Defined steps

The position values of master and slave are rounded to a multiple of the defined in-
crements X steps/Y steps.

Option field None The position values are not rounded.

Input field X steps Value for Defined steps 
The position values of the master are rounded to a multiple of the value entered.

Input field Y steps Value for Defined steps 
The position values of the slave are rounded to a multiple of the value entered.

Control field
Activate Expert Mode

Values of the profile objects Sloped Sine (Bestehorn) and Polynomials can be modi-
fied.

Control field
Normalized Velocity and Ac-
celeration for curves

Scaled display of the derivations.

Control field
Show Derivatives of Poly-
gons as Interpolated Points

In the linear interpolation, the speed is mathematically indicated as staircase and 
the acceleration as pulse.

Control field
Use same Scale for 
Backgound Axis like Active 
Axis

The axes in the background are indicated with the same scaling as the axis in the 
foreground. This enables the profiles to be compared directly.

Input field Product number Number of the product. The index of the profile data is integrated in the structure of 
the controller.

Input field Path LCx-file Display of the index for storing the LCx-files.

 Note!

Information on the single menu items can be found in the Online Help.

Make sure that the product numbers are not assigned twice and the correct path 
has been selected for the LCx-file.

If the project is stored with Save as..., it should be stored in the same directory as 
the LCx-files.
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6.1.4 Step 4: Defining the file name and directory for a project

 Tip!

We recommend to store the project now so that the settings in the dialog boxes do 
not get lost. In case of simple storing the project is called Noname.

An own project directory should be prepared for each project to be created. For this
purpose, the project should be stored with Save as into a particular project directo-
ry.

 • All path names within a project are relative and refer to the project directory.

 • If you want to transfer a project to another PC, simply copy the project directory 
to the corresponding PC.

 How to define the file name and directory for a new project...

1. Go to the Save as dialog box and select the directory in which you want to store the 
new project.

2. Enter a name for the new project in the File name input field.

3. Click OK to confirm the settings for the new project and close the Save as dialog 
box.

4. Go to the New project dialog box and click Next to proceed with the next step.

6.1.5 Step 5: Adding a slave axis

New slaves are added at the end of the list. You can enter a symbolic name for the new
slave which will be indicated on your worksheet.

 Tip!

The menu commands mentioned are partly also included in the context menu of
the right mouse button.
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 How to add another slave to your worksheet...

1. Mark the master axis in the object list.

2. Select the command EditSlave axesAdd new axes.

 • The dialog box Project settings of slave 2 is displayed (optional). You can accept 
the settings.

3. Define the name and properties of the slave axis in the dialog box Project settings.

 • The name of the slave is also used as name for the LCx file.

 • The maximum product number determines the minimum number of curves. 
The maximally possible entry depends on the target system.

�How to define the properties of the slave...  ( 26) 

4. Select OK to accept the setting and close the dialog box.
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 Create for the example a project with three slave axes. 

 The finished product must look as follows:
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6.1.6 Creating further products

 How to create further projects in »Cam Designer Basic«:

1. Select the command FileOpen to open a project already created from the direc-
tory which already contains project data (*.cam).

2. Select an available product to be loaded and press the Open button.

 • The selected product, in this example product2, is loaded by the »Cam Designer 
Basic«.

3. Select the command EditProject settings to open the dialog box Settings.

 Note!

The path of the LCx-file must not be changed.
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4. Enter a product number which has not been assigned yet, e.g. 3, into the register 
General, input field Product number.

5. Store the profile e.g. as product3 and process it, if required.

Next steps

Now you can assign the import files for the slave to the product and add more slaves and
products to your worksheet, if required.
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6.2 Open an existing project

 Tip!

 • It is possible to open several projects (worksheets) simultaneously in the »Cam 
Designer Basic«. The commands for arranging the worksheets can be found in 
the "Window" menu.

 • With a click on the entries 1...4 in the File menu you can open one of the four 
projects edited last.

 How to open an existing project...

1. Click the symbol    in the symbol bar or select FileOpen.

2. Select the corresponding project file (*.cam) in the dialog box Open.

3. Press the button Open .

 • After this, the project worksheet will be displayed in the workspace.

6.2.1 Selecting the properties of a slave

The properties of a slave can always be changed.

 How to change the properties of a slave...

1. Select the corresponding slave axes and select Properties of the slave axis from the 
menu of the right mouse button.

2. Go to the Project settings dialog box and enter the new settings.

�How to define the properties of the slave...  ( 26) 

3. Select OK to accept the settings and close the dialog box.
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 Tip!

If you want to change the settings of several axes/products you can also use the
command EditProject settings....

In the Project settings dialog box that appears you can quickly change between the
different axes/products by clicking the corresponding tabs:

6.2.2 Deleting a slave

 How to delete a slave...

1. Select a certain slave axis in the project structure.

2. Select EditSlave axes...Delete a slave axis or select Delete slave axis from the 
menu of the right mouse button.

3. Confirm the query with Yes or No accordingly.

 Note!

This function only deletes a slave from the project/worksheet. The correspond-
ing LCx file is not deleted!

Deleting a slave cannot be undone!
L 2.1 EN - 09/2005 35



Cam Designer Basic
Operation
Connection with the OPC server
6.3 Connection with the OPC server

The internal Lenze DriveServer is used for communication between »Cam Designer Basic«
and target system and LCx-file transfer. 

 The DriveServer provides easy integration of drives into open automation structures 
based on OPC (OLE for Process Control).

 A specially adapted variant of the DriveServer and the bus server for the system bus 
(CAN) is part of the »Cam Designer Basic« installation package.

 Select FileConnect to OPC server to connect the Cam Loader to the OPC server or 
cancel the connection.
A hook in front of the menu command indicates the connection with the 
OPC server.

6.4 Downloading the drive data

If connection with the OPC server has been established it is possible to transfer the drive
data for several slaves in one step. �Connection with the OPC server

 The configuration files (LCx files) for the selected axes are created first.

 If you have an online connection with the corresponding target system the LCx file will 
be directly transferred to the target system.

 How to download the drive data...

1. Select FileDownload of several axes... .

 • This command can only be executed if the Cam Loader is connected to the OPC 
server.

2. Go to the Download to controllers and select the slaves to be downloaded:

 • If the option If necessary, download all data without queries is activated the 
data will be downloaded without further queries.

 • If the option Do not show this dialog again until next program start is activated 
this dialog will not be indicated again until the next program start. This can be 
useful for the commissioning of standard systems or in case of frequent down-
loads.

 Note!

With the 9300 servo PLC, the LC9 file can only be downloaded if the target sys-
tem includes a DDS project based on Template Cam.
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3. Click the Start Download button to start the data transfer.

Note: If you have not yet assigned a drive to one of the slaves the Drive selection 
dialog box opens automatically.

 • Double-click the drive to be assigned to the slave in the DriveServer tree:

 • Click OK to confirm your selection and repeat the assignment for other slaves, if 
necessary.

6.5 Saving the project

 Click the  icon or select FileSave to save the project.

 Tip!

Save your project at regular intervals to protect your data against power failures or
system problems.

If you want to create a backup project on another data carrier or in another direc-
tory use the command FileSave as... instead.

�Saving a project under another name

6.6 Saving a project under another name

 How to save an open project under another name...

1. Select FileSave as... to open the Save as dialog box.

2. Go to the Save as list field and select the directory in which you want to store the 
project.

3. Enter a name for the new project in the File name input field.

 Note!

If you open several project simultaneously in the »Cam Designer Basic«, this 
function refers to the project in the active window.

 Note!

If you open several project simultaneously in the »Cam Designer Basic«, this 
function refers to the project in the active window.
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4. Click OK to save the project under the specified name in the selected directory and 
close the dialog box.

 • If you select the command FileSave the project will be saved with the new set-
tings.

 Tip!

This way you can create a new project or a backup project on another data carrier
or in a directory other than the project directory on the basis of the current project.

6.7 Exiting Cam Designer Basic 

 Select FileExit or click the Window icon U in the Title bar to exit the »Cam De-
signer Basic«.

 Note!

Information on the single menu items can be found in the Online Help.

Make sure that the product numbers are not assigned twice and the correct path 
has been selected for the LCx-file.

If the project is stored with Save as..., it should be stored in the same directory as 
the LCx-files.

 Note!

If you have not saved the changes made in one or several projects you will be 
asked if you want to save them before exiting the Cam Loader.
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7 Functions

7.1 Working with the worksheet

To create a cam profile in the »Cam Designer Basic«, specify the required data (boundary
conditions) on the worksheet using graphical elements. This worksheet has two levels ar-
ranged on top of each other. The lowest level is the Object Input Mode and the second level
is the Interpolation Mode.

In each of the levels the graphical elements of the underlying levels are visible and are used
for the following calculations. Only the elements of the active level can be edited, not the
elements of the underlying level(s). This principle is analogous to working with tracing pa-
per. Here, too, information from the lower sheets is available without being able to change
them.

7.2 Settings for the worksheet

Select EditProject settings... to open the Settings dialog box. Here you can change the set-
tings of the corresponding project.

7.3 Object Input Mode

The Object Input Mode uses graphical elements (objects) to describe the problem to be
solved.

 Note!

 • Ensure that the maximum value of the range is higher than the minimum val-
ue.

 • If you change the area boundaries afterwards and the project already con-
tains graphical objects, the objects outside the new area boundaries will be 
deleted!
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7.4 Interpolation mode

In Interpolation Mode, a table of base points is generated from the ideal cam. These value
pairs can then be transferred to the selected target system (Servo PLC,
ECS EA... or 9300EK servo cam).

Uniform distribution of the base points

All points are distributed with the same spacing along the domain.

7.5 Worksteps required for a new cam

The following steps are required to create a new cam:

�Settings of the worksheet ( 41) 

�Creation of profiles ( 41) 

 Note!

Before executing the interpolation, ensure that the curve trace is closed.
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7.6 Settings of the worksheet

 How to configure the worksheet:

1. Select the menu command EditProject settings in the »Cam Designer Basic«.

 • The Settings opens.

2. Go to the Settings dialog box, change to the Master or Slave tab for the master and 
slave axis and define the units for the axes.

3. Close the Settings dialog box with OK.

7.7 Creation of profiles

A simple profile is created and transferred to the controller.

For a better representation and obtaining a zero axis, go to the Settings dialog box of the
slave axis and select a negative value (e.g. -20,000) in the Minimum input field and a posi-
tive value (20,000) in the Maximum field.

 Tip!

The following figure shows the options of creating a profile in the »Cam Designer 
Basic«.

 How to create a profile:

1. Select the command ViewObject Input Mode to take the worksheet to the input 
mode.

2. Create the graphical elements required by using the command in the Draw menu.

3. Create a profile using all tools available. Ensure that the profile objects do not over-
lap each other and the profile is closed.

4. Go to the interpolation mode selecting View Interpolation mode.

5. Compile the profile selecting FileCreate and download LCx-file.

6. The profiles, cams etc. are transmitted to the LCx-files.
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The worksheet and time derivation might look as follows:

Profile object Function

A Table Creates a polyline. The base points are connected by lines. If 
the object is selected, it can be edited using the command 
EditObject Properties...

B Line: Section with a straight line.

C 5th-grade polynomial (x5) This section contains a mathematical
f(x)=ax5+bx4+cx3+dx2+ex+f

D Sloped sine function This section contains a sloped sine function
42 2.1 EN - 09/2005 L



Cam Designer Basic
Functions

Closed profile
7.8 Closed profile

 Tip!

To clearly represent the creation of closed profiles, only the corresponding sections 
of the »Cam Designer Basic« are shown.

 How to create a closed profile:

 First, the important sections (gradients, lines etc.) of the profile must be defined.

 Then, the sections must be connected without jerk, if possible. For this purpose, the 
»Cam Designer Basic« has

– the sloped sine function

– the 5th-grade polynomial (x5)

A jerk-free connection in a profile means:

 The coordinates of the end point of an object must be identical with the initial point of 
the following connected object.

 The gradient of the end point of an object must be identical with the following connect-
ed object.

Optimise the connection between the 5th-grade polynomial (x5) and a sloping line.

Here, the right end point of the polynominal must be connected with the left end point of
the line.
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 Select the line with a mouse-click.

 Select the menu command EditProject settings.
Go to the Line properties dialog box to open the Conditions register.

 Select and copy the value for velocity. The tab cannot be edited.

 Select the 5th-grade polynomial (x5) with a mouse-click.

 Select the menu command EditProject settings.
Go to the 5th-grade polynomial properties to open the Conditions register.

 Paste the copied value into the input field Right Velocity.
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The characteristic of both objects is smooth at the connecting point.

 Proceed the same way for all connections. A closed profile with several objects can look 
as follows : 
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7.9 The cam group

Select ViewEdit Cam in the »Cam Designer Basic« to take the bottom window (output ar-
ea) to the corresponding mode.

7.9.1 Defining the cam type and cam reference

 Tip!

The cam group can either refer to the X axis or to the Y axis. The cam group func-
tions are available in the context menu of the right mouse button.

 How to define the cam type and cam reference:

1. First, define the cam reference for the current data set under Cam for Slave Axis.

 • Subsequent changes are not possible. The selected cam data will be deleted and 
must be entered again.

2. The cam types for the individual tracks can be defined using the context menu of 
the right mouse button.

 • If you right-click in the track, you can directly change the came type.

3. Select Add New Cam to add a new cam to the corresponding track.

 • You can add up to four cams to every track.

 Note!

Only available for Software Package - Cam

The settings only apply to the product selected. For the other products, the set-
tings have to be repeated.

Position cam in positive effective direction
Position cam in negative effective direction

Position cam Both
Time-based cam in positive effective direction
Time-based cam in negative effective direction
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7.9.2 Cam types

Select Properties of Cam to edit the cam subsequently. In this dialog, time and length data
can be accurately entered. The dialog box is always the same for all cam types. Only the cor-
responding fields on the dialog box are active.

Illustration Meaning

Position cam in positive effective direction
Switch on and switch off point are defined by positions.
The cam switches if the direction of the axis is positive (positive speed).

Position cam in negative effective direction
Switch on and switch off point are defined by positions.
The cam switches if the direction of the axis is negative (negative speed).

Position cam Positive and negative
Switch on and switch off point are defined by positions.
The cam switches in positive and negative direction of the axis.

Time-based cam in positive effective direction
The cam switches on at the switch on point if the direction of the axis is positive (positive 
speed).
After the selected time, the cam switches off.

Time-based cam in negative effective direction
The cam switches on at the switch on point if the direction of the axis is negative (negative 
speed).
After the selected time, the cam switches off.

Dialog object Meaning

Input field Left Initial value of the cam

Input field Right Final value of the cam

Selection field Effective Di-
rection

Positive or negative effect

Input field Length [ms] Cam is active (only with time cam)
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7.10 Export of profile data

 Exporting the profile data to the controller via

– Drive PLC Developer Studio (Servo PLC and ECSEA).

– Global Drive Loader.

– Cam Loader.

Target system - Servo PLC, ECSEA and 9300EK servo cam

 How to export the profile data:

1. The data must be compiled before being exported.

 • For this purpose select ViewInterpolation Mode or click  and then select Ed-

itStart of Calculation or press .

2. Select the corresponding slave axis in the »Cam Designer Basic« by means of dou-
ble-click.

3. Go to the interpolation mode and press the LCx file.

 • If this function is executed for the first time, a dialog appears which is confirmed 
with OK. The system now creates a file with the name of the slave axis and the 
ending *.lc9 or *.lc7.

 • Compiling must be repeated for new profiles, cam groups or position markers 
and changes made.

 • After every compiling, the data are transferred to the *.lc9-file or *.lc7-file.

The following two steps are only required for the Software Package - Cam Offline down-
load.

4. Double-click ResourcesCamSupport in the DDS.

5. Click Add Profile Data to Project .

 • A dialog appears in which you can select the *.lc9-file.

 Tip!

Do not forget to save your CamDesigner Basic project on hard disk or diskette, in 
case you want to make subsequent changes. Select FileSave as... to save the 
CamDesigner Basic project under a new name.

 Note!

The 9300EK servo cam exclusively works with the Online download.
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 Repeat the above-described steps to create all cams required by means of the »Cam De-
signer Basic«.

 After creating all profiles required by means of »Cam Designer Basic«, you can exit the 
»Cam Designer Basic« with FileExit.

7.11 Cam Designer Basic Online Download

 How to make an Online Download:

1. Switch the »Cam Designer Basic« online by clicking FileConnection to OPC server 

or  .

 • The button online/offline is only active if the LDS-DriveServer has been started. 

The icon  for the LDS-DriveServer is situated in the status bar.

 • If the red point in the icon becomes green, the system is online.

2. Select EditProject settings to open the Settings dialog box.

3. Select in Controller data the drive to which the data is to be downloaded.

4. Select FileCreate and download LCx-file or  to activate the profile or cam 
download.

 • The data for the current slave axis are written into the *.lcx-file.

 • After the download has been started with the button, a progress dialog appears. 

 Tip!

For the commissioning of production machines, the *.lc9-file can be attached to the 
PLC program.

 Note!

The download time increases if

 • a high bus load (cross communication) exists.

 • many data was changed.
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8 Appendix

8.1 Error numbers, causes & remedies

Error number Cause Remedy

Errors within the DriveServer

E7C18000 Error during download preparation. Repeat download.

E7C18001 PLC has not stopped. Stop the PLC program in the target system.

E7C18002 Controller inhibit is not set. Set controller inhibit in the target system 
(e.g. via terminal 28 or code C0040).

E7C18003 Incorrect data type (no LC9 file). Create new LC9 file.

E7C18004 Check sum check is negative
(faulty check sum).

Restart the download. Increase time-out 
time in the system bus configuration tool 
(e.g. to 3 seconds).

E7C18005 Item can momentarily not be accessed due to 
download.

Repeat download after a few minutes or re-
start your PC. 

E7C18006 Target system is momentarily busy copying 
RAM blocks.

Start the PLC program in the target system.

E7C18007 Error occurred after the download. Repeat download.

E7C18008 Error after version comparison during down-
load of an LC7 file.
 • Different versions in LC7 file and target 

system. 

Update the operating system of the 9300 EK.

E7C18009 No template "Cam" in the target system. Create DDS project based on Template Cam 
and transfer it into the target system.
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8.2 Glossary

A

Absolute data model Contains both the X and the Y coordinate. Therefore requires more space than
the relative data model. The points are 1:1 transferred from the Cam Loader to
the target system:

 • Advantage: The distance between the points can be variable. This allows to 
optimise the distribution of the points according to the cam profile charac-
teristics.

 • Disadvantage: Compared to the relative data model, less points can be 
saved.

�Relative data model

Application window Window in which programs are displayed under Windows.

C

Code Lenze device parameter used to select the device functionality.

COM Abbreviation for "Component Object Model": Architecture developed by Mi-
crosoft® for the interaction of separately executable software components
(objects) that communicate with each other in the same way and are only con-
nected to each other when the program is being executed.

D

DCOM Abbreviation for "Distributed Component Object Model": COM in which the
executable objects can be distributed to different computers within a local
network.

�COM

DDS Abbreviation for "Drive PLC Developer Studio": Development environment for
the creation of IEC 61131 programs for Lenze PLCs.

Document window Window with graphical user interface displayed by a user program in which a
document is created, displayed and edited. Document windows are usually
sub-windows of the program windows. 

Drive PLC Developer Studio See DDS.

DriveServer Lenze software which enables easy integration of drives into open automa-
tion structures based on OPC ("OLE for Process Control").

�OPC

G

Global Drive Loader Lenze software used to transfer PLC programs, parameter sets and application
data to Lenze target systems.

H

Hyperlink Highlighted reference which is activated by a mouse click.
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I

IPC Abbreviation for Industrial PC. Industrial PCs are used in case of special envi-
ronmental conditions, e.g. dirt or vibrations. They are slot CPUs with powerful
processors and TFT displays (often with touch screens).

O

OLE Abbreviation for "Object Linking and Embedding": Integration of operational
objects into other applications, e.g. Microsoft® Excel spreadsheets into Micro-
soft® Word documents.

OPC Abbreviation for "OLE for Process Control": Defines an interface based on the
Microsoft® Windows® technologies OLE, COM and DCOM which enables data
exchange between different automation devices and PC programs regardless
of driver and interface problems.

�COM
�DCOM

P

PDF Abbreviation for "Portable Document Format". Universal file format devel-
oped by Adobe for the exchange of electronic documents. The Adobe® Read-
er® is provided free of charge and can be used to display and print PDF files
independently of the application and platform used to create them.

PLC Abbreviation for "Programmable Logic Controller".

�PLC

PLC Abbreviation for "Programmable Logic Controller".

�PLC

Relative data model Only contains the difference between adjacent Y coordinates and therefore re-
quires less space than the absolute data model. The distance between the X
coordinates is transferred as a fixed-comma value to the target system. This
leads to a certain difference between the imported data and the coordinates
calculated by the target system. To compensate for this inaccuracy, the Y val-
ues are re-calculated by means of interpolation . 

 • Advantage: Compared to the absolute data model, more points can be 
saved.

 • Disadvantage: The distance between the X coordinates of the points must 
always be the same.

�Absolute data model

T

Title bar Bar at the top of the application window including the program icon and the
program name on the left and the window icons on the right.

V

VDI 2143 VDI guideline "Motion rules for cam mechanisms"

W

Window icon Button at the right end of the title bar which can be used to change the size of
the window or to close the window.

Worksheet Table including all axes and products of a system or machine project.
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